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VISUAL Liquid Web COV Generic User 
User Manual 

Disclaimer of Warranty 
Avizent™ and its affiliates are committed to providing the best quality product possible, but specifically 
disclaim warranty of any kind and shall not be liable for loss of profit or any other damages. The Avizent 
software, its modules and the contents of this manual are provided as is and are subject to change without 
prior notice. The information contained in this document represents the current views of Avizent on the 
issues discussed as of the date of publication. This manual describes available modules and sub-
applications for Avizent products, including items which may not be included in the base delivery model, 
which may be optional or which may be separately priced. Because Avizent must respond to changing 
market conditions, it should not be interpreted to be a commitment on the part of Avizent, and Avizent 
cannot guarantee the accuracy of any information presented after the date of publication.   

Trademarks 
The VISUAL Liquid Web software product and the VISUAL Liquid Web logo are trademarks of Avizent 
in the United States and/or other countries. All rights reserved. All other product names and services used 
throughout this manual are trademarks of their respective companies. 

Copyrights 
Complying with all applicable copyright laws is the responsibility of the user. Without limiting the rights 
under copyright, no part of this document may be reproduced, stored in, or introduced into a retrieval 
system, or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, or 
otherwise), or for any purpose, without the express written permission of Avizent. 

Avizent may have patents, patent applications, trademarks, copyrights, or other intellectual property rights 
covering subject matter in this document. Except as expressly provided in any written license agreement 
from Avizent, the furnishing of this document does not give you any license to these patents, trademarks, 
copyrights, or other intellectual property. 

© 2008 Avizent. All rights reserved. 

Any example companies or persons depicted herein are fictitious. No association with any real company 
or persons is intended or should be inferred. 
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System Requirements 
The following table outlines the system requirements for optimal performance. 

Item Minimum Recommended 
Software * Citrix ICA client for 

Windows 
Citrix ICA client for Windows 

Internet Browser IE 6 SP2, SSL 2 and 3 
enabled 

IE 6 SP2, SSL 2 and 3 enabled 

Connection 56 KB  Broadband 
Screen Resolution 1024 x 768 1024 x 768 

   
   
   
   

 
*See the companion guide “VISUAL Liquid Web  -  Citrix client Installation” for details on installing Citrix. Citrix 
allows you to use complex hosted applciations over the internet with only your computer and an internet connection 
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About 
This document is intended as a high-level guide for COV Anonymous Users of the Avizent VISUAL 
Liquid Web product. This document provides a description of the VISUAL Liquid Web application, 
including instructions for accessing and using the application, and how to reach technical support. 

Text Conventions 
The following text conventions are used in this document. 

Element Usage 
bold text Characters that you type exactly as shown; menus and menu commands, 

command buttons, command prompts; list or drop-down boxes titles and 
selections; tab and dialog box titles and options 

Italic Font Variables for which you supply a specific value; information that you supply 
ALL CAPITALS Acronyms, names of certain commands, keys on the keyboard 
Initial Capitals Names of applications, screens, programs, field names 

Graphic Alerts 
The following graphic alerts are used in this document. 

Element Description 

 
Caution—Alerts you to potential problems, such as data loss or security breaches. 

 
Example—Provides a hands-on interactive lesson, or indicates material that helps 
clarify the current discussion. 

 
Note—Alerts you to supplementary information. 

 
Tip—Provides additional information that may be helpful to task completion such as 
shortcuts. 
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Getting Started 

 
VISUAL Liquid Web is an electronic forms processing and data capture system. VISUAL Liquid Web 
ensures that all the information necessary to submit a COV Employer’s Accident Report (EAR) is 
captured on its easy-to-use screens. This feature ensures that all EARs submitted have the minimum state 
required information completed.  

VISUAL Liquid Web 2.2 integrates directly with the VISUAL Claims Studio™ software suite, so there is 
never a need to re-key information. Field and document level validation ensures that documents adhere to 
the configured document specific rules. 

As an early innovator in the design of web site submission of electronic event and first reporting we 
formed EFROI.COM™. This online hosted service allows clients to electronically capture Event and 
State First Reports of Injury data over the web. EFROI.COM is the simple, fast, and cost-effective way to 
file events. 

VISUAL Liquid Web users will also enjoy the ability to generate and print forms.  
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 Accessing VISUAL Liquid Web 
 

1. In your Internet browser’s address field, type https://apps.frankgates.com/vaear/auth/login.aspx  and 
press Enter. 

 

Result: The Visual Liquid Web Intake home page displays. 
 

2. Click the Log In button in the box on the upper left of the screen 

 

 

 

 

 

 

Result: The Applications box displays 

https://apps.frankgates.com/vaear/auth/login.aspx
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3.  Click Employee Accident Report in the Applications box. 

 
 

 

 

 

 

 

 

 

Result:  The Citrix logon script will run, followed by the appearance of the VISUAL Liquid Web 
log in screen. 

 

Note: You do not need to fill the 
“Password” field. Skip this prompt and 
click on the Login button. 
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4.  Click Login on the Login Screen. 

 

 

Result:  VISUAL Liquid Web appears. 

 

  

If you have problems logging in, contact helpdesk@avizentrisk.com or 800-727-4283 for assistance. 

Closing the VISUAL Liquid Web Application 
To exit the application, on the File menu, select Exit. The application will close. If you have open EARs 
with unsaved changes, the system will prompt you to save the changes before closing. 

Accessing Technical Support 
Technical support for this Avizent product is available through the Help Desk 
(helpdesk@avizentrisk.com or 800-727-4283). 

mailto:helpdesk@avizentrisk.com
mailto:helpdesk@avizentrisk.com
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Navigating VISUAL Liquid Web 
Once you are logged in, VISUAL Liquid Web’s home screen displays. The primary navigation for 
VISUAL Liquid Web is found in the toolbar and in the left pane. The larger Content pane is on the right. 
You can also navigate using the menus.  
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Menus 
VISUAL Liquid Web contains two menus: File and Edit.  Each menu’s options are explained below. 

File 
The File menu contains the following options:  

 
■ New Document—Enables you to open a new COV EAR. 

■ Exit—Closes the VISUAL Liquid Web application. 

 

Edit 
The Edit menu contains the following options. These options are only available when an EAR is open. 

 
■ Cut—Deletes the highlighted text and saves a copy of it on the clipboard. 

■ Copy—Copies the highlighted text to the clipboard. 

■ Paste—Pastes the text previously cut or copied to the clipboard. 

■ Find—Searches the open EAR for the text you specify. 
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Toolbar 
The toolbar contains buttons which are shortcuts to various commands. The table below lists the standard 
toolbar buttons in VISUAL Liquid Web.  

 

Button Description 

 
New Document—Enables you to enter a new EAR into the system.  

Standard Buttons 
In addition to the toolbar buttons, other buttons are available throughout the application. Not all buttons 
are available on all screens. The following table contains a listing of all of the buttons available in the 
application.  

Button Description 

 
Print—Generates an electronic copy (.PDF) of the EAR which can be printed. 

 
Submit—Submits the completed EAR to the system designated reviewer. 
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Content Pane 
 

The Content Pane will display the Employer’s Accident Report. 
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Left Pane 
The left pane contains the following areas. 

 

■ User Information—Displays the current day’s date and your 
application user name. 

■ Validation Results—Contains a listing of the data fields 
which are required for the COV EAR. This list is updated as 
you enter information, so that you can see at-a-glance which 
required fields still need to be completed. 

 

 

 
Tip—You can also double-click on an item in the Validation Results field’s list to jump to its entry field 
in the EAR. 
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quid Web 

Using VISUAL Liquid Web 
Your main task in VISUAL Liquid Web will be to enter EARs (Employer’s Accident Report). This 
section provides information on this task as well as how to perform other auxiliary tasks such as printing 
an EAR. 

Entering a New EAR 
You can access the EAR entry form in one of two ways: 

■ From the File menu, select New Document, select EFROI, and then select COV EAR. 
Result: A blank COV Employer’s Accident Report displays. 

■ Click the New Document toolbar button, select EFROI, and then select COV EAR. 
Result: A blank COV Employer’s Accident Report displays. 
 

REQUIRED FIELDS : Based on data processing needs, these are subject to change. Please consult 
with your HR Administrator to clarify which fields you are expected to complete. 

Fields listed in the Validation Results area on the left pane are system required. They must be completed 
to be accepted by the MCI claim administrator. Please see your HR Administrator to determine which 
fields you are expected to complete as a Generic or anonymous user. 
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Example—The following example steps you through opening a COV Employer’s Accident Report 
form using the New Document toolbar button and entering information in all of the fields. 
 

1. Click the New Document toolbar button, select EFROI, and then select COV EAR. 
Result: A blank COV Employer’s Accident Report displays. You can now start entering information 
into the form. 
 

 
Note—It is your responsibility as an Anonymous User to complete the section of the EAR 
titled “This section to be completed by Employee/Supervisor” 
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2. In the Employer field, click on the Show Display button. From the drop down 
selection fields, select an Agency, and any applicable sub-agency.   

 

 
Result: The screen displays selected agency and sub-agency. 

 

3. Click the Show Display button again. 

 

 

 

 

 

 

 

 

 

 

 

Result:  The names of applicable HR contacts defined at a selected sub-agency will display.  If 
there are no contacts at that level, the names of the HR contacts at the Agency level will display.  
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4. Select the injured worker’s employer from the list. 
Result: The employer’s information is displayed as shown in the example below. 

 
5. With the employer’s information displayed, press TAB.  

Result: The employer information is entered on the form and the cursor moves to the next data entry 
field on the form as shown in the example below. 

 

 
Note—Notice that after the injured worker’s employer was entered the Employer Name 
field was removed from the field list in the Validation Results area. The Name of 
Employer area is also no longer bordered in pink. 
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6. In the Validation Results area, double-click on Social Security Number. 
Result: The cursor is positioned in the Social Security Number field of the Employee Accident 
Report form. 

 

 
7. Enter the injured worker’s social security number. 



VISUAL Liquid Web 

Avizent © 2008 ●800-777-4283 ● www.AvizentRisk.com Page 18 

8. In the Validation Results area, double-click on Employee First Name. 
Result: The cursor is positioned in the First field. 

 
Note—Notice that after the injured worker’s social security number was entered that the 
Social Security Number field was removed from the field list in the Validation Results area. 
The Social Security Number field is also no longer bordered in pink. 

 

9.  Enter the injured worker’s first name. 

 

10.  In the Validation Results area, double-click on Employee Last Name. 
Result: The cursor is positioned in the Name of Employee (Last) field. 

 
11.  Enter the injured worker’s last name. 
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12.  In the Validation Results area, double-click on Date of Injury. 
Result: The cursor is positioned in the Date of Injury field. 

13. Click the Date of Injury drop-down arrow. 
Result: A Calendar displays. 

14. Use the calendar to select the employee’s date of injury. 

 

Continue entering additional information that you have available, following the included list of 
Required Fields. You are encouraged to complete as much of the form as possible. Once the form is as 
complete as possible, you can submit the Employer Accident Report. See Submitting an EAR for more 
information. 

You also have the option of requesting that a notification be emailed to you, or anyone you specify, when 
the claim is submitted. See Requesting a Submission Notification Email for more information. 

 
Tip—You can move from field-to-field on the form by pressing the TAB key. 
 
It is recommended that you use the “Tab” button to move through the form. Note: Tabbing 
to a “Yes/No” type button field will automatically select the first choice. You may change 
your choice, or if you want to keep it empty, press your “ENTER” button on the keyboard 
to unselect.  
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Data Entry Features 
The following features are available to ease your data entry: 

■ Required Fields—The required fields have a pink border. They are also listed in the Validation 
Results area. The Validation Results area acts as a checklist for required information. As the required 
fields are completed, they are removed from the Validation Results area. 

■ Numeric Fields—Information that is normally displayed with formatting, such as dashes in phone 
numbers or social security numbers, can be entered with or without the dashes.   

■ Drop-down Selections—Enter the first character to move directly to that point in the selection list. 
Use Up and Down arrows to navigate further. 
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Submitting an EAR 
Submitting an EAR “promotes,” or forwards, the document to the Named User for review. To submit an 
EAR, click the Submit button on the EFROI toolbar. 

If you have previously saved the document, it is submitted to the system specified reviewer.  

If you have not saved the document, you are prompted to enter a subject name. 

 
 

 
Note—It is suggested that the subject include the claimant’s last name, first name and 
date of injury as shown above. 

 

After you have entered a subject name and clicked OK, the document is submitted to the system specified 
reviewer. 
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Requesting a Submission Notification Email 
You may request that an email notification be sent to you or someone else when the EAR that you are 
entering is submitted. 

With the EAR open on your screen, place your cursor in the Email Addresses to send submission 
notification field as shown below: 

 
In the Email Addresses to send submission notification field, enter the email address(es) of the 
individual(s) to receive submission notification. 

 
Note—To send to multiple addresses, insert a comma “,” between email addresses. Do 
Not Use Any Spaces Between email Addresses. 
There is no limit to the number of email addressees you can enter. 

 

The system saves this notification and will send a submission notification email to the listed addresses 
when the EAR is submitted to the Named User.  

Closing an EAR 
If you need to close an open EAR, click on the X in the upper right corner of the EFROI toolbar. The 
EAR will close. 

 

 
Caution—If you close a new EAR without submitting it, all of the data entered will be lost. 
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Printing an EAR 
Printing produces an electronic copy of the EAR which can then be printed in hard copy.  

When you are entering a new EAR, a Print button is available in the EFROI toolbar. 

 
To print the EAR, follow the steps below: 

1. Click the Print button. 
Result: A PDF version of the EAR is generated. Adobe Acrobat launches and displays the PDF on 
your screen. 
 

15. Click the Print icon the Acrobat toolbar. 

Result: The Print dialog box displays. 
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16. Specify the desired settings and click OK. 
Result: The EAR is printed to the specified printer. 
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Viewing/Updating an Open EAR 
To view and/or update an open EAR, click on the desired EARs name from the open EAR tabs. 
 

Tip—You can have up to 12 forms open at one time. When you try to open the 13th form, you 
will receive a message stating that you have reached the maximum number of open forms. 
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